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Preface

This User Guide has been implemented by Boot & Work, S.L. working

under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience

This User Guide is intended for the following audience:

Persons in charge of introducing automation devices.
Persons who design automation systems.
Persons who install or connect automation devices.

Persons who manage working automation installation.

& Warnings:

Unused pins should not be connected. Ignoring the directive may damage the
controller.

Improper use of this product may severely damage the controller.

Refer to the controller’s User Guide regarding wiring considerations.

Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

Maintenance must be performed by qualified personnel familiarised with the
construction, operation, and hazards involved with the control.

Maintenance should be performed with the control out of operation and disconnected
from all sources of power.
Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.
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The M-Duino WIFi/BLE Family PLCs are Open Type Controllers. It is required that you
install the M-Duino WiFi/BLE PLC in a housing, cabinet, or electric control room. Entry
to the housing, cabinet, or electric control room should be limited to authorised
personnel. Failure to follow these installation requirements could result in severe
personal injury and/or property damage. Always follow these requirements when
installing M-Duino family PLCs.

In case of installation or maintenance of the M-Duino please follow the instructions
marked in the Installation and Maintenance section.

Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le contréleur.

Une utilisation incorrecte de ce produit peut endommager gravement le controleur.
Reportez-vous au Guide de l'utilisateur du controleur pour les considérations de
cablage.

Avant d’utiliser ce produit, il incombe a l'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui 'accompagne.

La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

La maintenance doit étre effectuée avec I'équipement hors service et déconnectée de
toutes les sources d'alimentation.

Faites attention lors de I'entretien des composants sensibles a |'électricité statique. Les
recommandations du fabricant pour ces composants doivent étre suivies.

Les automates de la famille M-Duino sont des contréleurs de type ouvert. Il est
nécessaire d'installer I'automate M-Duino dans un boitier, une armoire ou une salle de
controle électrique. L'accés au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de la
famille M-Duino.

En cas d'installation ou de maintenance du M-Duino, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

Ne débranchez pas I'équipement en présence d'une atmosphere inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphere
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE

OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

e Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

e Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.
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Intended use or of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in
the catalogue and the associated technical documentation. If third-party products and
components are used, they must have been recommended or approved by Industrial
Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct It
must respect the permissible ambient conditions. You should also follow the indications
and warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or
manipulated by qualified personnel for the task entrusted and observing what is
indicated in the documentation corresponding to it, particularly the safety instructions
and warnings included in it. Due to their training and experience, qualified personnel
are in a position to recognize risks resulting from the handling or manipulation of such
products / systems and to avoid possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.
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Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.

The control and drive components of an Industrial Shields PLC are approved for
industrial and commercial use in industrial line supplies. Their use in public line
supplies requires a different configuration and/or additional measures. These
components may only be operated in closed housings or in higher-level control
cabinets with protective covers that are closed, and when all of the protective devices
are used. These components may only be handled by qualified and trained technical
personnel who are knowledgeable and observe all of the safety information and
instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU
Machinery Directive, the machine manufacturer must consider the following residual
risks associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning,
operation, maintenance, and repairs caused by, for example: — Hardware defects
and/or software errors in the sensors, controllers, actuators, and connection technology
- Response times of the controller and drive — Operating and/or ambient conditions not
within the scope of the specification — Condensation / conductive contamination —
Parameterization, programming, cabling, and installation errors — Use of radio devices /
cellular phones in the immediate vicinity of the controller — External influences /
damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by,
for example: — Component malfunctions — Software errors — Operating and/or
ambient conditions not within the scope of the specification - External
influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions -
Influence of electrostatic charging — Induction of voltages in moving motors — Operating
and/or ambient conditions not within the scope of the specification — Condensation /
conductive contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose
a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are
too close.

5. Release of environmental pollutants or emissions as a result of improper operation
of the system and/or failure to dispose of components safely and correctly.
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Warranty and Limitations of Liabilit
Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANTABILITY,
NON-INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE
PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR
USER ALONE HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET
THE REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS
DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONSIBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPRIATE MODIFICATION OR
REPAIR.
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ETL Listing Mark-Direct Imprint information
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INDUSTRIAL SHIELDS

1 General Description M-DUINO WiFi/BLE product

1.1 Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is
important to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the
shield from below and D the shield from above. Having a B and a C in the middle of

them.:
E 11 i
b : i W-:
W W W W W W
ZEZZ = ZZ=ZZ
QRRR . RERQ
Lm0 T D ZONR O @ L
sy ' C ZONE
we B ZONE
(g4 'AZONE

e The inputs in the zone B are named 10.X, being X any number suitable in the
Shield. Outputs are named as Q0.X and relays as R0.X

e The inputs in the zone C are named 11.X, being X any number suitable in the
Shield. Outputs are named as Q1.X and relays as R1.X

e The inputs in the zone D are named 12.X, being X any number suitable in the
Shield. Outputs are named as Q2.X and relays as R2.X

11



1.2 Reference table
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Reference Table

Model Reference
PLC M-Duino General Family
M-Duino PLC Arduino Ethernet & WiFi & BLE 19R I/Os Analog / Digital Plus 007001000100
M-Duino PLC Arduino Ethernet & WiFi & BLE 21 1/Os Analog / Digital Plus 007001000200
M-Duino PLC Arduino Ethernet & WiFi & BLE 38AR I/Os Analog / Digital Plus 007001000700
M-Duino PLC Arduino Ethernet & WiFi & BLE 38R I/Os Analog / Digital Plus 007001000300
M-Duino PLC Arduino Ethernet & WiFi & BLE 42 I/Os Analog / Digital Plus 007001000400
M-Duino PLC Arduino Ethernet & WiFi & BLE 50RRA 1/Os Analog / Digital Plus 007001000900
M-Duino PLC Arduino Ethernet & WiFi & BLE 53ARR I/Os Analog / Digital Plus 007001001000
M-Duino PLC Arduino Ethernet & WiFi & BLE 54ARA 1/Os Analog / Digital Plus 007001001100
M-Duino PLC Arduino Ethernet & WiFi & BLE 57AAR I/Os Analog / Digital Plus 007001000800
M-Duino PLC Arduino Ethernet & WiFi & BLE 57R I/Os Analog / Digital Plus 007001000500
M-Duino PLC Arduino Ethernet & WiFi & BLE 58 I/Os Analog / Digital Plus 007001000600

To find the reference of your M-Duino WiFi/BLE PLC, check the arrow in the picture below. In

the example, the reference is:

12
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Zones Table
Model Zone A Zone B Zone C Zone D
M-Duino WIFi/BLE PLC 19R+ v Relay - -
M-Duino WiFi/BLE PLC 21+ v Analog / Digital - -
M-Duino WiFi/BLE PLC 38AR+ v Analog / Digital Relay -
M-Duino WiFi/BLE PLC 38R+ v Relay Relay -
M-Duino WIFi/BLE PLC 42+ v Analog / Digital [Analog / Digital -
M-Duino WiFi/BLE PLC 50RRA+ v Relay Relay Analog / Digital
M-Duino WiFi/BLE PLC 53ARR+ v Analog / Digital Relay Relay
M-Duino WiFi/BLE PLC 54ARA+ v Analog / Digital Relay Analog / Digital
M-Duino WiFi/BLE PLC 57AAR+ v Analog / Digital |[Analog / Digital Relay
M-Duino WiFi/BLE PLC 57R+ v Relay Relay Relay
M-Duino WiFi/BLE PLC 58+ v Analog / Digital [Analog / Digital |Analog / Digital

The distribution of the different features that provide the M-Duino WiFi/BLE PLC Family is the

following one:

(5 Relay Outputs and
6 Digital Outputs, 3
of which can work as
Analog Output)

(5 Relay Outputs and
6 Digital Outputs, 3
of which can work as
Analog Output)

Shield B Zone C Zone D Zone
13 Inputs 11 Inputs 10 Inputs
(13 Digital Inputs, 6 (11 Digital Inputs, 6 (10 Digital Inputs, 4
of which can work as | of which can work as | of which can work as
Analog Input) Analog Input) Analog Input)
Analog Shield
11 Outputs 11 Outputs 8 Outputs
(11 Digital Outputs, 3 | (11 Digital Outputs, 3 | (8 Digital Outputs, 2
of which can work as | of which can work as | of which can work as
Analog Output) Analog Output) Analog Outputs)
9 inputs 7 inputs 9 inputs
(3 Relay Inputs and 6 | (3 Relay Inputs and 4 | (3 Relay Inputs and 6
Digital Inputs, 4 of Digital / Analog Digital Inputs, 4 of
which can work as Input) which can work as
Relay Shield Analog Input) Analog Input)
11 Outputs 11 Outputs 8 Outputs

(4 Relay Outputs and
4 Digital Outputs, 2
of which can work as
Analog Output)

13




1.4 A Zone Features

Rev. 3: 30-09-2022

Shield

A Zone

Communication
Shield

(1x) Ethernet

(1x) USB

(1x) 12C

(1x) TTL

(1x) RS-232

(1x) HALF/FULL Duplex RS-485
(1x) SPI external Port

(1x) RTC

(1x) uSD Socket

(

1
1
1
1x) WiFi/BLE

X
X
X
X

~—— N S S

1.5 Mechanical dimensions and weights

Measures Table

Model Height (mm) [Width (mm)|Depth (mm)|Max weight (g)

M-Duino WiFi/BLE PLC 19R+ 119.5 70.1 101 394
M-Duino WiFi/BLE PLC 21+ 119.5 70.1 101 394
M-Duino WIFi/BLE PLC 38AR+ 119.5 94.7 101 504
M-Duino WiFi/BLE PLC 38R+ 119.5 94.7 101 504
M-Duino WiFi/BLE PLC 42+ 119.5 94.7 101 504
M-Duino WIFi/BLE PLC 50RRA+ 119.5 119.3 101 614
M-Duino WIFi/BLE PLC 53ARR+ 119.5 119.3 101 614
M-Duino WIFi/BLE PLC 54ARA+ 119.5 119.3 101 614
M-Duino WIFi/BLE PLC 57AAR+ 119.5 119.3 101 614
M-Duino WiFi/BLE PLC 57R+ 119.5 119.3 101 614
M-Duino WiFi/BLE PLC 58+ 119.5 119.3 101 614

14



1.6 General Features
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CONNECTABLE PLC ARDUINO 24Vcc M-DUINO

MODEL TYPE Controller General Specifications Information
Fuse protection (2.5A)
Input Voltage 12 1o 24Vde Polarity protection
24 Vdc
Input rated voltage —
Rated Power 30w
| max. 1.5A
Size Check size and weight table
Clock Speed 16MHz
Flash Memory 256KB of which 8KB used by bootloader
SRAM 8KB
EEPROM 4KB
Communications I2C — Ethernet Port — USB — RS485 — RS232 — Max232-Max485-W5500 -

SPI - (1x) RX, TX (Arduino pins)

Sim800L

USB consideration!

Only meant for uploading or debugging, not
always connected as a serial in a project!

Cannot be working in a final
application

An/Dig Input 10bit
(0-10Vce)

0 to 10Vdc
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vdc

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc

Max read time: 116 us

Digital Isolated Input
(24Vcce)

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc

All Digital Inputs are PNP .
Click here' for more
information.

Max read time: 8 us

* Interrupt isolated
Input HS (24Vcc)

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24Vdc

Max read time: 8 us

Analog Output 8bit
(0-10Vce)

0 to 10Vdc
| max: 20 mA
Separated PCB ground
Rated Voltage: 10Vdc

Output frequency: 2Hz

Rising edge time: 150 ms
Falling edge time: 252 ms

Digital Isolated
Output (24Vcce)

5 to 24Vdc
| max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Imax 24Vdc: 410 mA

With 70 us delay,
freq is 6.849 MHz
with pulse width of 106 us

Rising edge time: 476 ns
Falling edge time: 42.8 us

! https://www.industrialshields.com/blog/arduino-industrial-1/post/pnp-digital-inputs-on-industrial-plc-193

15
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Digital Isolated
Output Relay

250Vac max —| max: 5A

30Vdc max —I| max: 3A
Galvanic Isolation

Diode protected for Relay

For more information. click
here?

PWM Isolated Output
8bit (24Vcc)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Direct Arduino Pin
Output

0 to 5Vdc
| max: 40 mA
Rated Voltage: 5 Vdc

Max frequency: 77 kHz

Rising edge time: 200 ns
Falling edge time: 200 ns

5V Pull-up

i i H 0 to 5Vdc
Direct Arduino Pin Lm0 M read fime: 8 us
InpUt Rated Voltage: 5 Vdc
12C Pin Max frequency: 100 kHz

Rising edge time: 10 us
Falling edge time: 150 ns

One-Wire Pin

Usable pins:
Pin 2, Pin3, SCL, SDA, RX0, TX0,
MISO, MOSI, SCK

Freqliency: 800 kHz

Expandability

12C - 127 elements - Serial Port RS232/RS485

* By using this type of signal can no longer use Digital signal

(24Vdc)

*https://www.industrialshields.com/blog/arduino-industrial-1/post/learning-the-basics-about-internal-relays-of-an-i

ndustrial-plc-180

16
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2 Technical Specifications:

2.1 General Specifications:

Item

M-Duino WiFi/BLE Family PLC

Power supply

voltage DC power supply 12 to 24Vdc
vo?tzgza:?l'?ge DC power supply 1M14t0254Vdc ~ "7
conzzmi)l;ion DC power supply 30W max.
External Pov\zgl;t:gz Py 24Vde ===
power supply Power supply 200Ma

output capacity

Insulation resistance

20MQ min.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength

2.300 VAC at 50/60 Hz for one minute with a leakage current of 10mA max. Between all
the external AC terminals and the protective ground terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0° to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage)

-20° to 60°C

Power supply holding time

2ms min.

Weight

Check size and weight table

2.2 Performance Specification:

Arduino Board

ARDUINO MEGA 2560

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a

programming language. “similar to the C”. hitp://arduino.cc/en/Tutorial/HomePage

Microcontroller ATmega2560
Flash Memory 256KB of which 8KB are used by the bootloader
Program capacity (SRAM) 8KB
EEPROM 4KB
Clock Speed 16MHz
Clock Speed 16MHz

17
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2.3 Symbology
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Table that includes all the symbology that is used in the serigraph of the M-Duino WiFi/BLE PLC

Family:

Symbol

JL
ik
X

M
/M

=[>

Standard No. /
Standard Title

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

2004/108/EC /
Electromagnetic
Compatibility

ISO 7000/
Graphical symbols
for use on
equipment

ISO 7000/
Graphical symbols
for use on
equipment

Standard
Reference No. /
Symbol Title
5031 / Direct
Current

5032 / Alternating
Current

5130/ Pulse
General

5017 / Earth,
Ground

5115/ Signal lamp

CE Marking

0434B /
Warning symbol

5036 / Dangerous
Voltage

Symbol Meaning

Indicates that the equipment is
suitable for direct current only;
to identify relevant terminals

Indicates that the equipment is
suitable for alternating current
only; to identify relevant
terminals

To identify the control by which
a pulse is started.

To identify an earth (ground)
terminal in cases where
neither the symbol 5018 nor
5019 is explicitly required.

To identify the switch by
means of which the signal
lamp(s) is (are) switched on or
off.

CE marking indicates that a
product complies with
applicable European Union
regulations
Indicates a potentially
hazardous situation which, if
not avoided, could result in
death or serious injury

To indicate hazards arising
from dangerous voltages

18



3

Precautions
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Read this manual before attempting to use any of the M-Duino WiFi/BLE PLC Family and follow
its descriptions for reference during operation.

3.1 Arduino Board

The M-Duino WiFi/BLE Family PLCs include Arduino Mega Board as controller.

3.2

Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate an M-Duino according to the performance specifications described in

this manual.

Before using M-Duino under different conditions from what has been specified in this manual

or integrating M-Duino to nuclear control systems, railroad systems, aviation systems, vehicles,

combustion systems, medical equipment, amusement machines, safety equipment and other

systems, machines, and equipment that may have a serious influence on lives and property if

used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure that the rating and

performance characteristics of M-Duino are sufficient for the systems, machines, and

equipment, and be sure to provide the systems, machines, and equipment double safety

mechanisms. This manual provides information for programming and operating the M-Duino.

4 M-Duino Pinout
IOs Table
Analog | Digital Isolated | Digital Isolated | Digital/Analog

Model Reference Input Input Output Output Relay Output
19R+ | 007001000100 4 2 0 3 8
21+ 007001000200 6 7 5 3 0
38AR+ | 007001000700 10 9 5 6 8
38R+ | 007001000300 8 4 0 6 16
42+ 007001000400 12 14 10 6 0
50RRA+ | 007001000900 12 10 4 8 16
53ARR+ | 007001001000 14 11 5 8 15
54ARA+ | 007001001100 14 15 9 8 8
57AAR+ [ 007001000800 16 16 10 8 7
57R+ | 007001000500 12 6 0 8 23
58+ 007001000600 16 20 14 8 0
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5 Serigraphy
5.1 A Zone connection (Communications)
[
Base
A Zone ] i
M-Duino Arduino Function %EE}E:?
Connector Pin WIFL/ 115
Pin3/10.6
AREF AREF Arduino Pin S
sQw sQwW Arduino Pin
IOREF IOREF Arduino Pin B
3.3Vdc 3.3Vdc Arduino Pin 2
5Vdc 5Vdc - N
GND GND GND =
g
=
o
NC
_;%82&
o in
Base
A Zone —E—
M-Duino Arduino Function
Connector Pin L ]
SCL 21 12C/SS peited
SDA 20 12C/SS .
RXO 0 RX0/SS i
TXO0 1 TX0/SS gnd
- = - SCL .
TX 16 RX2§seriaI 2% Do T
RX 17 TX2(serial 2 ne
zZ- - RS485 T2
Y+ - RS485 z
B- - RS485 i
A+ - RS485 A
PIN3 3 Arduino Pin Pin3
50 SO 50 SPI 5151
51 SI 51 SP| 5]
52 SCK 52 SPI Svac
Ving Ve %
in in 5
PIN2 2 Arduino Pin H
GND - Gnd L
GND - Gnd
24Vdc Power Supply
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Configuration Switch® (see section 8 1o
eelect the correct configuration for
outputs. Enabling communications diables
some F0s)

Fax1iTx1 = Pins used lor the WiFi module

Communicaton Pins

Powar supply connectors (24Vde - GND)

SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any

device.
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Ethernet Reset USB-B

RTC Programmable button
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5.2 Analog/Digital Zone connection (I/0s)

X Zone
M-Duino Function
Connector
IX.12 Analog/Digital In*
IX.11 Analog/Digital In*
1X.10 Analog/Digital In
IX.9 Analog/Digital In
IX.8 Analog/Digital In
IX.7 Analog/Digital In
(-)1X.6 GND IX.6
IX.6/INT Interrupt X In?
(-)IX.5 GND IX.5
IX.5/INT Interrupt X In?
(-)Ix.4 GND IX.4*
IX.4 Digital Input*
(-)Ix.3 GND IX.3
IX.3 Digital Input
(-)Ix.2 GND IX.2
1X.2 Digital Input
(-)Ix.1 GND IX.1
IX.1 Digital Input
(-)1X.0 GND IX.0
IX.0 Digital Input

*Connectors IX.12, IX.11 and 1X.4 are not connected (NC) in D Zone.

X
s
%3

Top Zone

%1
%10
%
K.’
%4
%

%

Kl
it
it
%3
X
Kl

Led indicator 1/Os state

X Zone
M-Duino Function
Connector
GND GND
AX.7 Analog Out*
AX.6 Analog Out
AX.5 Analog Out
QVvdc External Isolated Out Vdc
COoM(-) External Isolated Out GND
Qx.7 Digital/PWM Out*
QX.6 Digital/PWM Out
QX.5 Digital/PWM Out
Qx.4 Digital Out*
QXx.3 Digital Out
Qx.2 Digital Out
Qx.1 Digital Out
Qx.0 Digital Out

*Connectors AX.7, QX.7 and QX.4 are not connected (NC) in D Zone.

% See section 5.4 to know more about interrupt pins.

* Maole: wse comectly monfgueation for

ust this signal

[E R LIHE H
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Analog/Digital Inputs

Interrupt Inputs (isolated)

Digital Inputs {izolated)

Configuration Switch*

(s=e section 8 io select the corect
configuration for aulpuls).

Anabog Outputs
‘oltage Supply/Reference for

Digital/(PWM Outputs (isolated)

Digital Outputs
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5.3 Relay Zone connection (I/0s)

X Zone |
M-Duino Function
Connector
RX.8 Relay Out
RX.7 Relay Out
RX.6 Relay Out
RX.5 Relay Out*
RX.4 Relay Out Relay Outputs
AX.2 Analog Out*
AX.1 Analog Out
AX.0 Analog Out
GND GND
QXx.2 Digital/PWM Out*
Qx.1 Digital/PWM Out
QXx.0 Digital/PWM Out
COM(-) External Isolated Out Gnd
Qvdc External Isolated Out Vdc Analog Outputs (Switch
*Connectors RX.5, AX.2 and QX.2 are not connected (NC) in D Zone. Configuration)
Top Zone _ .
B Digital'PWM Outputs (isclated)
oo BN o A A U S R A I
X X X X X X X xX X H

i; % Qé l ’ ; o ;; }
SR = : o o
T2 9% ®ERR —
Led indicator 1/Os state
X Zone N
M-Duino Connector Function
4
RX.3 Relay Out
E%% Eelay 8u§ Relay Oufputs
GND GND piiten
IX.5 Analog/Digital Input B 10vde
IX.4 Analog/Digital Input Digital
IX.3 Analog/Digital Input -
IX.2 Analog/Digital Input B
IX.1/INT* Interrupt X In § - 24vic
(-)ix.1 GND IX.1 — oo
IX.0/INT* Interrupt X In . 15 .
(-)ix.0 GND IX.0 £ |§.1 Analog/Digital Inputs
: : £ laa
3 i
et |
f - I_ﬁ;l:':l Interrupt Inputs {isolated)
8EE  _fc
£y ] s
§E E : :g Caonfiguration Switch®
ISR E 1 (sea section & to select the corect
* See section 5.4 to know more about interrupt pins. I configuration for outputs),
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5.4 Interrupt equivalence table

See the Reference Table in order to know the specific device details.

Rev. 3: 30-09-2022

Analog/Digital Relay
PLC PLC
Zone | PLC Input | Interrupt M-Duino Pin PLC Input | Interrupt M-Duino Pin
0.6 INT1 PIN3 0.1 INT1 PIN3
5 0.5 INTO PIN2 0.0 INTO PIN2
1.5 INT5 PIN19 - - -
¢ 1.6 INT4 PIN18 - - -
25 INT3 PIN21 2.1 INT3 PIN21
P 2.6 INT2 PIN20 2.0 INT2 PIN20

If WiFi is activated through switches, interrupts INT5 and INT4 will not work.

Check this link for more information.
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6 Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed directly using C but it is much easier working with
Arduino IDE as it provides lots of libraries that help in the programming.

Industrial Shields provide boards for programming the PLCs much easier. Basically it is not
needed to define the pins and if those pins are inputs or outputs. Everything is set up
automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:
Arduino IDE 1.8.15 or above (better to always have the latest version).
Steps:
1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences e

Settings  Metwork

Sketchbook location:

fhome/anna/Arduino Browse
Editor language: English (English) hd (requires restart of Arduing)
Editor font size: 12
Interface scale: Automnatic % (requires restart of Arduino)
Theme: Default theme W (requires restart of Arduino)

Show verbose output during: compilation upload

Compiler warnings: None v
Display line numbers Enable Code Folding
Verify code after upload Use external editor
Check for updates on startup Save when verifying or uploading

Use accessibility features
Additional Boards Manager URLs:  Yapps.industrialshields.com/main/arduino/boards/package_industrialshields_indexjson 1

More preferences can be edited directly in the file
/home/annal.arduinol S/preferences.txt

(edit only when Arduino is not running)

0K Cancel
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2. In Additional Boards Manager URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3. Press OK to save the changes.

4. Go to: Tools -> Board: ... -> Boards Manager

File Edit Sketch Help

Auto Format Ctri+T
Archive Sketch
sketch jul21a

woid setup() | Fix Encoding & Reload
A oput your

Manage Libraries... Ctrl+Shift+
L Serial Monitor Ctrl+Shift+M
'-'D‘i(i‘ és:P:Eg“i Serial Plotter Ctri+Shift+L
} WiFi101 / WiFININA Firmware Updater

Model: "M-Duing 58+" >

. Arduino AVR Boards >
Port: "/devittyACMO (Arduino Mega or Mega 2560)"

. Industrial Shields boards >
Get Board Info

Programmer >

Burn Bootloader

5. Search for “industrialshields” on the browser.

s Manager

Type All v industrialshields

industrialshields

Boards included in this package:
ARDEOX family, ARDBOX DALI family, ARDEOX GPRS family, ARDECX LoRa family, ARDEOX WiFI/BET family, M-Duinge family, M-Duing DALT family,
M-Duina GPRS family, M-Duino LoRa family, M-Duing WiFI/BT family, Spartan family.

Online Help
Maore Info

1.1.38 v Install
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6. Click install (selecting the latest version).

Following these steps you will be able to see now the Industrial Shields Boards:

File Edit Sketch

Auto Format CtrkeT

Archive Sketch

sketch_sep26
void setup FixEnceding & Reload
I'1 put Y Manage Libraries...

Ctrisshiftst
} Serial Monitor Ctrl+Shifte
Serial Plotter CtrlsShiftel
void loop(
T1PUT Y vieingn s wiFiNIN Frmvare Updater i

B uine WiFi/BT family’ E Boards Manager.
>

Model: "M-Duino 19R+ WIF/BT"

N Arduino AVR Boards >
. Industrial Shields boards A family
industrialshields-esp32 > |~ Ardbox DALI family

Programmer: "Arduino as ISP > Ardbox GPRS family
Burn Bootloader Ardbox WIFUBT family

Ardbox LoRa family

M-Duino family

M-Duino DALI family

M-Duino LoRa family

Lino WIF/BT family

M-Duino WiFi/BT + GPRS famil

Once it is selected M-Duino WiFi/BT Family, an extra option will appear on Tools:

There, it can be selected the exact model for every family.

File Edit Sketch

Auto Format CtrleT

Archive Sketch

sketch_sep26
void setup FixEncoding & Reload

I1 pUt Y mManage Libraries... Ctri+shiftl

} Serial Monitor CtrisShifteM
Serial Plotter CtrivshiftL
void loop(
T1PUT Y vieion s wiRin Frmware Updater by
i

A-Duino WIFi/BT far

uine 19R+ WiFi/BT"

© M-Duino 19R+ WiFU/BT
> M-Duino 21+ WiFi/BT

Get Beard Info M-Duino 38AR+ WiFi/BT
M-Duino 38R+ WiFi/BT

Programmer: "Arduino as ISP"

M-Duino 42+ WiFi/BT

Burn Bootloader

1-Duino SORRA+ WIFI/BT

M-DUino 53ARR+ WIFI/BT

M-Duino S4ARA+ WiFi/BT

M-Duino STAAR+ WIFIBT

M-Duino 57R+ WiF/BT

(O M-Duino 58+ WiFi/BT
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Also there are some examples of programming in File -> Examples -> Examples for WiFi
module.
Furthermore there are some extra libraries that can be found in Industrial Shields github.

https://github.com/IndustrialShields/

7 How to connect PLC Arduino to PC

- Connect USB port from PLC to PC.

NOTE:
M-Duino WiFi/BLE Family uses B-USB cable.

- Open Arduino IDE interface:
- Select Industrial Shields boards -> M-Duino WIFI/BT Family

- Select the correct M-Duino Board (M-Duino 58+W!IFI/BT in our example).

File Edit Sketch Help
Auto Format Ctri+T
Archive Sketch
sketch_sep26

void setup FixEncoding & Reload

/1 put Yl Manage Libraries.. Ctriashift
} Serial Monitor CtrlsShifteM
Serial Plotter CirbsShifeel
void loop(|
/1 put Ly:

WIFi101 / WIiFININA Firmware Updater

}

EBoard: "M-Duino WiFI/BT family” >

Model: "M-Duing 19R+ WIF/BT" tll © M-Duino 19R+ WiFi/BT

> M-Duino 21+ WiFi/BT
Get Board Info IV-Duino 38AR+ WIFI/BT

M-Duino 38R+ WIF/BT
Programmer: "Arduino as ISP" >
M-Duino 42+ WiFi/BT
Burn Bootloader

M-Duino SORRA+ WiFi/BT

M-Duino 53ARR+ WiFI/BT
IV-Duing S4ARA+ WIFI/BT

Vi WiFi/BT

M-Duino 57R+ WiF/BT

() M-Duino 58+ WiFi/BT

- Select the correct port.

File Edit Sketch Tools Help

Aute Format CtrlsT
Archive Sketch
K [+ i
skelch_aug1 4 Fix Encoding & Reload

1 setup(] Manage Libraries... Crl+Shift+|
/ PSE Y91 Serial Monitor Ctrle Shifts M
Senal Plotter Chrl=Shift+ L

WiFI101 / WiFsNINA Firmware Updater

Pl
/ put ye Board: "M-Duino WiFV/BT family” »
Model: "M-Duino 19R+ WiFi/BT" »
! Port 1 Serial ports
Get Board Info COM?2 (Arduino/Genuino Mega or Mega 2560)
Programmer: “Arduino as 159 »

Bumn Bootloader 28
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8 How to connect PLC to power supply

- M-Duino WIFI/BLE Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT
REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

Make sure that the power supply mains output is not higher than 24Vdc.

— — — — — —

L rmeR SUPPLY

V CIC

GND

: 24 vde
L o e
\

— — — — — —

POWER
l2 to 24Vdc

\
|
|
)

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm DIN Rail:
-12Vdc / 24vdc

‘h"—
-2.5A 3s =y

*eao
-30W

Industrial Shields power supplies provide parallel operation, overvoltage protection, and
overcurrent protection. There is a LED inductor for power status, the power supply is
certified according to UL.

B0

-

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1.

WARNING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the
equipment must be separated from the dangerous voltage cables.
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9 Switch configuration

9.1 A Zone: Communications

A Zone

Switch OFF ON
SCL | XX SCL XX
SDA | XX SDA XX
WiFi | XX WiFi XX
WiFi | XX WiFi XX
Pin 3 | XX Pin 3 XX
Pin 2 | XX Pin 2 XX
SD | XX SD XX
FD | HD FD HD

OFF ON

This is an D Zone Switch example from M-Duino 58+ WIFI/BLE. In this
case, SCL, SDA, 11.6, 11.5, 10.6, 10.5, Q2.0 and HD are enabled. This
means SCL, SDA, WIFI, Pin 3, Pin 2, SD and FD are disabled.

SCL/12.6
SDA/12.5
WiFi/11.6
WiFi/11.5

Pin 3/10.6

Pin2/10.5

SD Q2.0
FD RS485 HD

OFF ON

4. SCL | XX: Choosing between SCL or the input XX. If the switch is ON, it enables XX and
disables SCL. If the switch is OFF, it enables SCL and disables XX. The serigraphy in the PLC will
indicate which input is referred to XX.

3. SDA | XX: Choosing between SDA or the input XX. If the switch is ON, it enables XX and
disables SDA. If the switch is OFF, it enables SDA and disables XX. The serigraphy in the PLC will
indicate which input is referred to XX.

2. WiFi | XX: Choosing between WiFi or the input XX. If the switch is ON, it enables XX and
disables WiFi. If the switch is OFF, it enables WiFi and disables XX. The serigraphy in the PLC will
indicate which input is referred to XX. Both WiFi switches must be enabled to activate WiFi
connection

1. WiFi | XX: Choosing between WiFi or the input XX. If the switch is ON, it enables XX and
disables WiFi. If the switch is OFF, it enables WiFi and disables XX. The serigraphy in the PLC will
indicate which input is referred to XX. Both WiFi switches must be enabled to activate WiFi
connection.
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4. Pin 3 | XX: Choosing between Pin 3 or the input XX. If the switch is ON, it enables XX and
disables Pin 3. If the switch is OFF, it enables Pin 3 and disables XX. The serigraphy in the PLC
will indicate which input is referred to XX.

3. Pin 2 | XX: Choosing between Pin 2 or the input XX. If the switch is ON, it enables XX and
disables Pin 2. If the switch is OFF, it enables Pin 2 and disables XX. The serigraphy in the PLC
will indicate which input is referred to XX.

2. SD | XX: Choosing between SD or the input XX. If the switch is ON, it enables XX and disables
SD. If the switch is OFF, it enables SD and disables XX. The serigraphy in the PLC will indicate
which input is referred to XX.

1. FD | HD: Choosing between FD or HD. If the switch is ON, it enables HD and disables FD. If
the switch is OFF, it enables FD and disables HD. Note: HD stands for Half Duplex and FD means
Full Duplex. Check section 11.2 for more information.

A Zone OFF ON
Switch OFF ON NC NC
NC - - NC NC
NC - - o RTC
NC | RTC - RTC ~RTC
NC | RTC - RTC

This switch enables the communication with RTC using I12C. Having both switches in ON mode
activates the communication, whereas if they are in OFF mode 12C is disabled to reach the RTC.
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9.2 Digital/Analogic Shield Switches

Digital/ Analogic Shield Switch

Switch OFF ON
NC - -
AX.7 | QX.7 AX.7 Qx.7
AX.6 | QX.6 AX.6 QX.6
AX.5 | QX.5 AX.5 QX.5

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know
what number takes X.

OFF ON We can see here an example switch from the C Zone
(Notice that X takes value 1 here).
NC NC
AlT7T QL7
AlB Q1.6
AlS5 Q15

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF
it can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide
this digital output is represented with QX.X, being X any number of the table above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will
provide this digital output is represented with AX.X, being X any number of the table above.

*IMPORTANT: In D Zone, output A2.7 | Q2.7 is not connected.
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9.3 Relay Shield Switches

Relay Shield Switch
Switch OFF ON
NC - -
AX.2 | QX.2 AX.2 Qx.2
AX.1 | ax.1 AX.1 Qx.1
AX.0 | QX.0 AX.0 Qx.o

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know
what number takes X.

OFF ON We can see here an example switch from the B Zone (Notice
NC NC that X takes value 0 here).
A0.2 Q0.2
A0.1 Q0.1
A0.0 Q0.0

For the Relay Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF it
can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide
this digital output is represented with QX.X, being X any number of the tables above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will
provide this digital output is represented with AX.X, being X any number of the tables above.

*IMPORTANT: In D Zone, output A2.2 | Q2.2 is not connected.
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10 M-Duino Arduino I/0s 5V pins

The M-Duino has some of the Mega board pins available. These pins can be programmed
according to Arduino features such as I/Os operating at 5V or any additional features present in
the pins (for example 12C communication in pins SCL and SDA). As these pins are directly
connected to the Arduino Mega board they are not as well protected as the normal inputs.
These pins are mainly meant to be used as prototyping.

The Arduino board available pins are summarised in the table below. In order to access some of
these pins the configuration switch must be set to OFF position (see section 9) and some extra
considerations must be taken in consideration when using these pins.

M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RX0 0
TXO0 1

RX 17
TX 16
MISO 50
MOSI 51
SCK 52
Pin 3 3 Communication switch: OFF
Pin 2 2 Communication switch: OFF

&*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than
5V. These terminals provide direct access to the Mega board.

Apart from the switch configuration there are some special conditions depending on these 5V.
Now it is going to be shown the considerations to operate with these pins.

10.1 12C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. A pull-up configuration means
that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case it
reads 5V when nothing is connected. The pull-up configuration is established by default in
these pins.

If it is meant to use them as an internal arduino direct PIN at 5V, it has to be considered that
they are pull-up inputs (2200Q resistor is used in the internal pull-up).

10.2 Serial 0 - RX0/TXO0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in
case that all the 5V pins are already performing a function. This is because they are shared with
the USB interface. If using these pins, the USB communication cannot be working at the same
time.
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When the PLC is not installed, the USB communication is normally required for debugging,
uploading and intercommunicating with the Ethernet controller. If using both interfaces at the
same time the Arduino board will get blocked.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be established as an external pull-up or pull-down circuit in order to correctly work with
these pins.

10.3 SPI - MISO/MOSI/SCK

These pins can only work as 5V pins if the Ethernet protocol is not going to be used. As the
Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours
cannot happen at the same time as the Ethernet would not work.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be established as an external pull-up or pull-down circuit in order to correctly work with
these pins.

10.4 Pin 2/Pin 3

To know how to configure these pins correctly, check section 9.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be established as an external pull-up or pull-down circuit in order to correctly work with
these pins.

11 A Zone Features: Communications & RTC & uSD

11.1 RS-232

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16
and 17 of the Arduino Mega).

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not
matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232
implementation.
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Click here® or here® to see more about this communication.

11.2 RS-485
For RS485 communication protocol the defined Arduino Mega pins are shown in the chart
below.
Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the RS-485 communication protocol there is only one switch that affects this
communication. The RS-485 protocol will be always enabled, the only switch that affects is the
one called “FD rs-485 HD” (See Section 9). This switch makes the choice between RS-485 Half
Duplex or RS-485 Full Duplex (RS-422).

Using the boards of Industrial Shields, there is a library that simplifies the RS-485
implementation.

Click here” or here® to see more about this communication.

11.3 I2C

I12C communication DOES NOT REQUIRE a pull-up resistor for the M-Duino. The pull-up resistor
is already implemented in the PCB.

I12C communication is configured by switches, so the switches must be configured in order to
enable the 12C communication (See section 9 for more information).

Industrial Shields does not provide any library to implement the 12C as it can be used with the
standard library of Arduino called Wire.

Click here® to see more about this communication.

> https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs232-of-an-industrial-plc-183

6 https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-rs-232-on-industrial-arduino-based-plc-16
7 https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs-485-of-an-industrial-plc-195

8 https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-connect-two-industrial-plcs-through-rs-485-213

S https://www.industrialshields.com/blog/arduino-industrial-1/post/i2c-bus-on-plc-arduino-for-industrial-automation-192
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11.4 SPI

The M-Duino pins used for the SPI bus are summarised in the table below. For SPI bus MISO,
MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely,
each of the connected devices will have a single and dedicated SS pin.

Function M-Duino connection Mega board pin
MISO 50 S0 50
MOSI 518l 51
CLOCK 52 SCK 52
Reset Reset Reset
SS SCL/SDA/RX0/TX0/RX3/TX3/Pin2/Pin3 21/20/1/0/15/14/2/3

Check the switch configuration at section 9 to enable SS pins.

Click here™ to see more about this communication.

11.5 TTL

M-Duino has two TTL ports, RX0/TX0, RX/TX. TTLO is accessed with the function Serial (pins O
and 1 of the Arduino Mega). TTL is accessed with the function Serial2 (pins 16 and 17 of the
Arduino Mega). See section 9 for more information.

11.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the IC compatible with
Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible with the
M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS Arduino
Mega pin 10).

Click here and here® to see more about this communication.

11.7 RTC

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the 12C protocol
communication, so it is required to have enabled the I12C protocol. This means 4 switches have
to be configured in order to enable the RTC features.

RTC SCL & RTC SDA must be set to ON mode to enable the 12C wires to the RTC. If they are in
OFF mode, the Arduino won’t communicate with the RTC. Look at section 11.3 for more
information.

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation
called RTC.

10 https://www.industrialshields.com/blog/arduino-industrial-1/post/bus-spi-on-plc-arduino-from-industrial-shields-191
1 https://www.industrialshields.com/blog/arduino-industrial-1/post/modbus-tcp-master-with-industrial-arduino-esp32-plcs-103

12 https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-modbus-tcp-slave-library-with-a-plc-controller-arduino-105
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Click here® to see more about this feature.
11.8 uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol
is always enabled, as there are no switches that configure it. However, there is a switch that
must be placed to ON mode in order to communicate with the uSD:

SD: If this Switch is OFF, it enables the Chip Select of the microSD socket. If the switch is in ON
mode the microSD can’t be used. Check section 9 for more information.

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of
the PLC, it is required to open the plastic found in the frontal part and the socket is located
under the supply of the Arduino.

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation
called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to
select the Chip Select of the uSD chip.

Click here!* to see more about this feature.

& Verify that the CPU is not actively running a process before inserting the memory card.

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the
operation of an online process or machine. Unexpected operation of a process or machine
could result in death or injury to personnel and/or property damage. Before inserting a
memory card, always ensure that the CPU is offline and in a safe state.

& Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la
carte mémoire.

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le
fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un
processus ou d'une machine peut entrainer la mort ou des blessures corporelles et / ou des
dégats matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est hors
ligne et en sécurité.

3 https://www.industrialshields.com/blog/arduino-industrial-1/post/rtc-test-on-m-duino-plus-version-51

14 https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-with-sd-card-in-an-industrial-plc-167
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11.9 WiFi & BLE

The WiFi and Bluetooth integrated module consists of a single 2.4 GHz Wi-Fi and Bluetooth
combo chip designed with the TSMC ultra-low-power, 40 nm technology. It is designed to
achieve the best power and RF performance, showing robustness, versatility and reliability in a
wide variety of applications and power scenarios. Some applications are Generic Low-power
loT Sensor Hub, Generic Low-power loT Data Loggers and Mesh Network.

It is designed for Internet-of-Things (loT) applications.
11.9.1 General Specifications:
Wi-Fi

e 802.11b/g/n
e 802.11n (2.4 GHz), up to 150 Mbps

Bluetooth

Bluetooth 4.2 BR/EDR BLE dual-mode controller
+12 dBm transmitting power
NZIF receiver with -97 dBm BLE sensitivity

11.9.2 WiFi & Bluetooth Module Configuration

In order to configure the WiFi & BLE module, you must connect it to a PC. To connect it you will
need a micro USB to USB cable.

The slot for the micro USB input is located on the right side of your equipment.

To load the program into the ESP32 you have to use the appropriate board. For that, update
our board to the latest version. Go to Tools -> Board -> Boards Manager. Search by
industrialshields-esp32.

Type Al ~ industrialshields-esp32

industrialshields-esp32

Boards included in this package:
WiFi/BT module, 10 I0s PLC family, ESP32 PLC family.

Online Help
More Info

21.2 v Install
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Now you are able to install the board. Go to Tools -> Boards -> industrialshields-esp32 -> WiFi
module.

File Edit Sketch Help

Auto Format Crrl+T
Archive Sketch
sketch_sep27,

void setup Fix Encoding & Reload

/1 put Y manage Libraries... Ctrl+Shift+l
1 Serial Monitor Ctrh+Shift+M
X Serial Plotter Crrh+ShifeL
void loop(
/1 put Ly:
p Y WiFI101 / WIFININA Firmware Updater Y
} .
Board: "WiFi module” bl Boards Manager...
>

. Arduino AVR Boards >
Get Board Info

Industrial Shields boards >

Programmer bl industrialshields-esp32 > 10105 PLC Family

Burn Bootloader ESP32 PLC Family

© WiFi module

The internal connection between the ESP32 module and the Arduino Mega is the following:

Arduino Mega Pinout ESP32 Pinout
5Vdc Ve
GND GND
Tx1 (Pin 18) TxD
Rx1 (Pin 19) RxD

WiFi and Bluetooth are always enabled as there are no switches that configure it. The WiFi and
Bluetooth module uses Seriall for communication.

More information:
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12 Examples

12.1 Communication system between M-Duino and WiFi module

As seen in the chart above, a Serial TTL communication is used to interact between Arduino
Mega 2560 board and ESP32 module. In this blog®, an introduction to this communication
between modules is done using an example code.

12.2 How to connect your ESP based PLC to Wi-Fi

If having problems connecting your ESP32 based PLC to Wi-Fi, follow this other blog®. There
you can find a brief description of the code provided and also an explanation about how the
ESP32 board and the Arduino shield are connected to each other.

12.3 Interact with M-Duino WiFi/BLE PLC via Bluetooth

To learn how to work with BLE from the ESP32 board, follow the instructions on this blog"’. In
it, a useful example of usage of the BLE feature is explained. In addition, communication
between the M-Duino board and the ESP32 is also covered in the blog.

15

https://www.industrialshields.com/blog/arduino-industrial-1/post/communication-system-between-m-duino-and-wifi-module-148
16 https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-connect-your-esp32-based-plc-to-wi-fi-452

v https://www.industrialshields.com/blog/arduino-industrial-1/post/interact-with-m-duino-wifi-ble-plc-via-bluetooth-480
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13 Instructions for interconnection between Industrial
Shields controllers

13.1 RS-232 Communication:

. M-Duino WiFi/BLE * Another Industrial -
" FamilyPLC | Shields PLC |
KRFC-6 Ferrite (4 Loops)
Tx M B TTX
RS-232 oy @i i\ R 3; ) o RS-232
SHIE ED CABLE
Ferrite KITA Fermite KITA

O XX ono
1224V @CX}O( 12/24V

13.2 RS-485 Communication:

13.2.1 Half Duplex

_M-Duino WiFi/BLE_ Another Industrial
Family PLC | Shields PLC |

KRFC-6 Ferrite (4 Loops)
A l'.“ = A
oo § PR rees
SHIELDED CABLE

Ferrite KITA Ferrite KITA

GND GND
iy SO | RO S
13.2.2 Full Duplex

" M-Duino WiFi/BLE- _ Another Industrial

KRFC-6 Ferrites (4 Loops)

A

B
RS-485 v

z

RS-485

Ferrite KITA Ferrite KITA

GND SHIELDED GABLES GND
1oy XY PO 1y2ay
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13.3 Ethernet

KRFC-6 Fermrite

. L: — Ethernet !
M-Duino WiFi/BLE Another Industrial
Family PLC Shields PLC

Ferrite KITA Femite KITA

22wy SO OO,

For Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet
crossover cable must be used.
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14 1/0 technical details:

A comparison between the waveforms of the I/0Os from the M-Duino WiFi/BLE Family PLC and
the Arduino Mega is done in this section.

Digital Output Waveform:

[ T Ll o ——
v

DIGITAL OUT

DIGITAL OUT

PWHM OUTPOUT

ARDUIND PWHM DUT

5. EEL) M 1.88m= CH1 ¥ 2686m.)
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Analog Out Turn-On:

]

AMNALOGOUT

ANALDG OUT
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15 Typical Connections

GND N ()00
SM2124V o o J 0.0
SHIELDED CABLE

Ferrite KITA

= S— i e T

SHIELDED CAELE / Doursoad the MDUINO LAYOUT: \

Y

Ferrite KITA

= l 0 POWER
2204 B oomaw
SHIELDED CABLE ,J Doumbond oo MOURO LAYOUT:
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SHIELDED CABLE

2024V a/c
GMND

Ferrite KIIA
224V B ocemAuANALOG W
- SHIELDED CABLE ~/  fexwewhaeeswen  \
' e U

Ferrite KITA
GND
cE )~
2r2av - DIMUTALANALOG IN
Dowrined e MOUNG LA YOUT:

SHIELDED CABLE
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010V
SHIELDED CABLE
@ 51224V %m—
GND
Ferrite KITA
GND {9
12124V

Ferrite KITA

0

ar

0.7
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SHIELDED CABLE

ALWAYS
CONNECTED
&
VOUT = Q/Vdc

SHIELDED CABLEf o wone tradata o \_
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SHIELDED CABLE

Gﬂb{ﬁ

2124V

Ferrite KIT/

Ferrite KITA
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VOUT = Q/Vde

SHIELDED CABLE

L
I
SHIELDED GAEL? o v e E

* Sew the swilch
configutarion (ON)
f 512124V
k o A
J ALWAYS
JU1 CONNECTED
SHIELDED CABLE

VOUT = Q/ Vide
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A
ALWAYS
DNMNECTED
Ferrte KITA
— GND :[9] POWER VOUT = 0/ Vide
24 I DAGTALPWM OUT
Dowrioad B MOURMO LAYOUT:

SHIELDED CABL Fom

\VJ .
SHIELDED CABLE

a0

e

\ * Analog Outs no led /

Qe * See the switch
) configutarion (OFF}

o8
o4 GND KF
o0

SHIELDED CABLE
NC|) O o2
Ferrite KITA \[:/
GND

i
POWER
S. 224V ¥ ]? I awwwosour
SHIELDED CABLE)
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16 Connector details
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The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 - 1881529*
connector from Phoenix contact.

In the PLC we can find other connectors too, and these are the references for them:

MC 0,5/ 4-G-2,5 - 1881464

MC 0,5/ 6-G-2,5 - 1881480

MC 0,5/ 9-G-2,5 - 1881516

Connection details (10 pins):

Article reference

MC 0,5/10-G-2,5 - 1881529

Height 8.1 mm
Pitch 2.5mm
Dimension 22.5mm
Pin dimensions 0.8x 0.8 mm
Pin spacing 2.5mm

'8 https://www.phoenixcontact.com/en-us/products/pcb-header-mc-0510-g-25-1881529

51


https://www.phoenixcontact.com/en-us/products/pcb-header-mc-0510-g-25-1881529

Rev. 3: 30-09-2022

For 1/0 and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406" connector from Phoenix

contact.

In the PLC we can find other connectors too, and these are the references for them:

FK-MC 0,5/ 4-ST-2,5 - 1881341
FK-MC 0,5/ 6-ST-2,5 - 1881367
FK-MC 0,5/ 9-ST-2,5 - 1881396

Connection details (10 pins):

Article reference

FK-MC 0,5/10-ST-2,5

Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?
Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20

19

https://es.farnell.com/phoenix-contact/fk-mc-0-5-10-st-2-5/plug-libre-muelle-2-5-mm-10-v/dp/1792814
?CMP=KNC-GES-GEN-KWL-PDP-High-Aov-phoenix-contact-15-July-22&mckv=_dc%7Cpcrid%7C60387320
4419%7C&gclid=CjOKCQjw_viWBhD8ARIsAH1mCd4jlzLvlJs5K_3|EpaW5Ango3FBLULTwiPFtyKaiP-rj4LSly6

7bWoaAuLnEALwW_wcB
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We can also find the relay connectors.

MCV 1,5/ 2-G-3,81 1803426% is the female connector, and MC 1,5/ 2-ST-3,81, GTIN UPC* is the
male one. Both are from Phoenix Contact.

Article reference | MCV 1,5/ 2-G-3,81 1803426
Height 12.6 mm
Pitch 3.81 mm
Dimension a 3.81 mm
Pin dimensions 0.8x 0.8 mm

Article reference | MC 1,5/ 2-ST-3,81 - 1803578

Height 11.1 mm
Pitch 3.81 mm
Dimension a 3.81 mm

20

https://www.tme.eu/es/details/mcv1.5_2-g-3.81/bloque-de-bornas-extraibles/phoenix-contact/mcv-1-5
-2-g-3-81-1803426/?brutto=1&currency=EUR&gclid=CjOKCQjw_viWBhD8ARISAH1mMCd763F0sGBmfjy5p
mZm9dKysA6ePciWt8md8utGsZX10fLpgsBx4mnoaAo9GEALwW_wcB

21
https://es.farnell.com/phoenix-contact/1803578/terminal-block-pluggable-2pos/dp/3704907?gclid=CjOK
CQjw_viWBhD8ARISAH1MCd6YjA37NgmaaFBXgbRyGEXfAM8gDodVOWZPfYsLLQhnVygDn8ufNslaAmgYE
Alw_wcB&mckv=_dc%7Cpcrid%7C575710444791%7Cplid%7C%7Ckword%7C%7Cmatch%7C%7Cslid%7C
%7Cproduct%7C3704907%7Cpgrid%7C131987845643%7Cptaid%7Cpla-372506228807 & CMP=KNC-GES-
GEN-SMART-SHOPPING-High-Jan-2022&gross_price=true
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17 DIN Rail mounting

Profilato o cappello TH 35-7,5
Top hot roil TH 35-7,5

Profilafo o coppello TH 35-15
Top hot rail TH 35-15

15
154
12004
152
RO8
R12
RO8
o~ -
=
+l
e~ —--—L— 1004
Sezione A/ Section A R12
o~ 2,2 min. finoa / To 2,5 max
=] et
1l
s Seaione A/ Sedtion A
CARATTERISTICHE METODO  UNMA'  BLEND FEATURES TEST UNITS BLEND
DIMISURA PC/ABS METHOD PUABS
Mecconiche Resisnzn o tmziane allo snervomerto JSTMDB38  MPo 68 Mechanicol test Resistonce i tensile stess o vield ASTMDE3E P 68
Resishin o tazioe o mitw MSTMDB38  MPo 48 Tonsdastiongth ASTMDE3E Wit 48
Alungamento a tottym JTMDA3E % 5 Ui o ASTIDE3B % 5
Modulo in flesione JSTMDT0  MPo 26894 Flading modults ASTDTI0 WP 2894
Prova lz0d con intoglio 5O1B0N4 W' 5 trod st notched 150180714 X' 55
Termiche Tomp di mmmollimento Viot metdo B ASTM 1525 °C 14 Thermal fest  Vieot sachering temprature method B ASTMDISES  °C 114
Tomperatun Ricot 1 1 MRy KTHDe48  °C 7 Rebeating tomperature 1.81 MPo ASTMDE4E  °C 97
Fisiche Peso gprifip SSTMD7T?  gdamd 121 Physicol test  Speciic gmuity ASTMDTS?  qu/and L2
Riti nello stompo JSTM DRSS 8% 0406 Mouid shrinkage ASTIDISE % 0405
Mol Flow Index 260°C- 98 KTWDI238 g0’ 111 Mt Fiow Index 260°C - 98K ASTMDIZE g1’ 1l
Comportamento Aubestingueren (rm g gesae) i V(08 Flame test  Sellafinguher (hidoess in o) [t g
alla fiommo Fib handesen. 37 mm EGE95.21  °C 90 Incondesients thioad 32 mim IECE9521  °C 90

Ialtrenic si ricerva il diritto di modificore il materiole con cui realizza i propri prodotti

senzo obbligo di preowiso.

Ialtonic con operate ony change of the meteriols without being obliged to forewarn.
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For optimal operation of the product, it must be located in an electrical cabinet with
IK08 mechanical protection. The minimum IP protection degree required is IP56.

18 Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and

rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.
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- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which are apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the 1/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particles,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the M-Duino Family PLC from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
M-Duino. When configuring the layout of the M-Duino inside your panel, consider the
heat-generating devices and locate the electronic-type devices in the cooler areas of your
cabinet. Reducing the exposure to a high-temperature environment will extend the
operating life of any electronic device. Consider also the routing of the wiring for the
devices in the electric cabinet. Avoid placing low-voltage signal wires and communications
cables in the same tray with AC power wiring and high energy, rapidly-switched DC wiring.

Provide adequate clearance for cooling and wiring M-Duino. Is designed for natural
convection cooling. For proper cooling, you must provide a clearance of at least 25 cm
above and below the devices. Also, allow at least 25 cm of depth between the front of the
modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product

standards should be followed.

The following factors should be considered when formulating a maintenance program:

55



Rev. 3: 30-09-2022

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a way
that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquidfilled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by an excess
of temperature.

- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.

- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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19 Revision Table

Rev. 3: 30-09-2022

Revision Number Date Changes
0 26/07/2019 First implementation
1 02/03/2020 Second implementation
2 08/06/2022 Third implementation
3 30/09/2022 M-Duino WiFi/BLE Family User Manual

Implementation
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